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Like You, We Wanted an Endless Stream of Qualified, 
Targeted Leads to Our Online Businesses… 

 
Know what we did? 
 

1. First, we learned how to make quick, easy Internet videos—even 
some that didn't require a camera.  

 
2. Then we learned how to drive massive traffic with them. 

 
While it was different than traditional online marketing, it was also fun and 
exciting—a lot more so than writing sales letters and paying for Adwords! 
 
If you'd like to know how we did it, we'll show you right here and now.  
 
Just beware—there's A HARD WAY and AN EASY WAY to get qualified, 
targeted Web site traffic. 
 
The Hard Way definitely works; it's how we did it when we started—before Frank 
Sousa, Michael Koenigs and I built Traffic Geyser. The Easy Way works just as 
well—but in a lot less time and with a lot less effort.  
 
Read on to learn how to do it yourself, both ways. 
 
And may you soon be showered with traffic, 
 

Rocket Helstrom 
San Diego, California 
info@trafficgeyser.com 
 
P.S. Resale rights are available for this ebook. If you'd like to resell, 
distribute or make this ebook available to your clients or subscribers for free, you 
must register here to personalize your copy and receive the most updated 
version along with images and other materials to help you promote it. 
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Part 1 – The Hard Way 
How to Make Quick, Easy Internet Videos 
If you own a video camera, one way to learn how to make quick, easy Internet 
videos is to watch the Internet Video Starter Kit, which you get as a bonus when 
you join our Traffic Geyser service. The Starter Kit takes you through the process 
step-by-step in a few short videos that take about two hours total to watch. It 
shows you:  
 

 What equipment you need 
 How to set it up—including lighting 
 How to capture video on your computer 
 How to edit it and save it properly  
 How to host it and 
 How to stream it to your Web page 

 
But if you don't want the hassle of shooting video, there is another way… 
 

STEP 1 – Write a short sales script 
STEP 2 – Create an audio file from your script 
STEP 3 – Marry images to it and generate a video file 

 
Here's an example of a short promo video we did using this technique. (Click to 
watch in a new window.) 
 

 
 
First, let's create an audio file from a short sales script that follows a proven 
formula in the next section. 
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How to Create Audio Files with Just a Telephone and a 
Computer 
If you don't have audio files already and you want to create new audio content 
without the hassle of equipment, here's a quick, easy, affordable way to do it.  
 
This technique uses a free third party Web service called Gabcast. Because it is a 
third party service, we can not control its quality and is not responsible or liable 
for its performance. Here's how to get started. 
 
Signup 
Go to Gabcast and sign up for the service. (NOTE: You need to click the 
activation link in the confirmation email Gabcast send you to proceed.)  
 

 
 
After you check the boxes indicating you agree to the Terms of Service and 
attest to being older than 13, fill in the Account Details page:  
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Gabcast will send a verification email to the address you supplied. You need to 
click the activation link in the email to proceed. Then login using your email and 
password. 
 
Create A Channel 
Next, choose the "Create" tab and click "My Account" to create a new channel. 
  

 
 
Fill in the details on this screen. Your "channel" is your repository for the audio 
files you create. You can set up different channels for different topics or 
categories. 
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Note the password for your Channel and for Channel Conference. (Passwords 
must be different.) You can also hold conference calls—audio interviews, 
teleseminars, etc.—for free with Gabcast and record them. 
  
Click "Submit" and then visit "My Channels" tab to get your call in details. 
 

 
 
Record Your Audio  
Make a note of the phone number and your channel number. Call the toll-free 
number and follow the prompts to record your audio. Gabcast gives you 200 MB 
of space for free and 60 minutes per recording. 
 
Don't know what to say? Use this quick start product or service promotion 
script guide to write a brief script for yourself. Then just read it over the phone 
when you record your audio. 
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Once you've recorded your audio, it will take a few minutes to appear in your 
Gabcast channel.  
 
Click on "manage episodes" in the lower left corner of the My Channels page. 
 
Your recording (called an "episode" by Gabcast) appears in your list as an 
untitled episode. You can "tag" your episode by clicking on the tag icon.  
 
Here you give your audio file a title and description. It'll make it easier to find if 
you create multiple files. You can play it and if you are unhappy with it, re-record 
it.  
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Download Your Audio 
Next you want to download your audio file. RIGHT-CLICK on the "Download File" 
link and choose "Save Link As..." from the menu. 
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Then simply save the .mp3 file to your computer drive. 
 
Now, once you have an audio file, what about Step 3 above? How do you add 
images to it and generate a video file? 
 
One way is to use the ingenious Slideshow Video Generator (follow link to 
watch a short video) in Traffic Geyser, which lets you add images, text slides, 
etc. to your audio files and create videos from them. (The Slideshow Video 
Generator uses either .mp3 or .wav audio file formats.) 
 
But there are other ways.  
 
How to Create a Slideshow Video Using Audio Files and 
Images 
First you need to acquire a video editing program. We're partial to Sony Media 
Software's Vegas program. You can get the basic package to do everything we're 
about to show you for less than $90 US. 
 
Go to the Sony Media Software site and select "Vegas" from the "Software" 
dropdown menu. 
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Then select the package you want to order. They all come with a free 30-day 
trial. We use the Vegas Movie Studio+DVD basic software in this demonstration 
but for our regular video editing and production, we use the full Vegas+DVD 
suite. 
 

 
 
NOTE: You don’t have to use Sony Vegas to create slideshow videos. You can 
use any of the other video editing programs like Adobe Premiere or even iMovie 
on the Mac. Most of the programs work similarly. 
 
Okay, once you've downloaded your free trial or purchased the software and 
installed it, launch the program. 
 
You'll see a screen with several tracks laid out on a timeline. You can add text 
media (slides), a couple video tracks and some audio tracks. 
 
You'll also have a folder open in the lower left corner where you can browse to 
your video raw materials folder that contains your audio and image files. 
 
In the lower right is a preview window, where you can see what your screen 
looks like at any point along the timeline. 
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Save Your Project 
The first thing you want to do is save your editing project. This is different than 
saving your finished video, which is called "rendering" we will accomplish at the 
end of our project. 
 
Saving your project now and repeatedly while you work will enable you to make 
changes to the tracks later and create a modified version. 
 
Select "Save As" from the "File" menu and give your project a name. In this 
example, I've called our project "Slideshow_Test." Vegas saves it as a Vegas File 
with the .vf file extension.  
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Insert Audio File 
Now add your audio track by navigating to the folder either in the lower left 
window or in a separate window, as shown in the next screen shot. 
 

 
 
Simply drag the .mp3 or other audio file to the "Voice" track in the timeline. 
 
If you click the Play button below the tracks, the audio track will play. Use these 
controls to monitor your progress and check your work along the way. 
 
For example, when you start adding images, you can check whether the 
transitions between them synchronize with the audio and make adjustments. 
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Size Your Project Frame 
The default size for a new Vegas project is 720 x 480 pixels. However, Internet 
video sites usually size uploaded videos to 320 x 240 pixels, which is a different 
aspect ratio. Before you start adding images to your slideshow project, you'll 
want to change the size of your project to 640 x 480 pixels, so it's the correct 
aspect ratio. 
 

 
 
Select "Properties" under the "File" dropdown menu and a "Project Properties" 
window like the one above will appear. Simply change the Width from 720 to 
640, click the "Apply" button in the lower right corner, then click "OK." 
 
Now you can begin to add your images. There are a few sources for images to 
use in your slideshow videos: 
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 Text slides you create inside Vegas 
 Images you create outside Vegas and import 
 Clip art photos or illustrations you find outside Vegas and import 

 
We create images outside Vegas using Adobe Photoshop but you can use any 
image processing software. Adobe offers a basic version of Photoshop called 
Photoshop Elements for Windows for $99 US but you can find it for less at 
discount stores like Costco. 
 
If you need images, DO NOT use images you don't own the rights to from the 
Web or other sources. (If you're not sure, it's likely you don't.) There are many 
sources for free, royalty-free images. One is Stock.XCHNG. Another is Microsoft 
Office Online's Clip Art Section. Make sure to read the terms of service for any 
stock photo site so you know what your responsibilities are. 
 
Now, we're going to show you how to create text slides in Vegas.  
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First, select the Text track by clicking in the control area next to the timeline for 
track number 1. Then, select "Text Media" from the "Insert" dropdown menu. 
 
A Video Event FX window will open like the one you see above. Here is where 
you create and edit your text slide. You can see the results of your creation in 
the preview window in the lower right corner of Vegas. 
 
You can select font, text size—even text and background color, which we'll see in 
a moment. 
 
You want to open and close your slideshow video with a text slide that includes 
your target Web site address. In this case, we created a slide that says "Discover 
the Amazing Traffic Generating & SEO Secret…www.TrafficGeyser.com." 
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Once you have entered your text, click on the "Properties" tab in the "Video 
Event FX" window to choose the text and background colors for your slide. Then 
close the pop up window and you will see the text slide on the timeline. 
 

 
 
You control how long the slide appears on the screen by dragging the right edge 
of the slide forward (longer) of backward (shorter). 
 
Insert Image 
Next, we'll import an image we created in Photoshop. In this case, it's a slide of 
the person speaking on the audio track (TrafficGeyser.com co-founder, Michael 
Koenigs) with his name and title below his photo. We saved the image as a 640 x 
480 pixel .jpg. 
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Insert the image by dragging it and dropping it on the Text track in the timeline, 
as shown below. 
 

 
 

Create Transitions Between Images 
To dissolve between one image (or text slide) and the next, it will help to expand 
or zoom in on the timeline. Do this by clicking anywhere on the timeline and 
scrolling up or down with the wheel on your mouse. 
 
You can see the difference in the screen shot below, where we've zoomed in on 
the timeline. Each second hash mark is more distinct. 
 
You can now make adjustments and manipulate the elements on the timeline 
more accurately. 
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In the next screen shot below, we've made several adjustments to the elements. 
 
We moved the entire audio track over three seconds to the right which means 
the sound won't start playing for three seconds once the video begins. 
 
We also listened to the audio and then shortened the text slide from 15 seconds 
(above) to about six and a half seconds in duration so that when Michael starts 
talking, we can dissolve from the Title text slide to the image of him with his 
name and title. 
 
Then we dragged that image of Michael to the left until it overlapped the text 
slide ahead of it by about a second and a half. (See below.) 
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Now when we bring the cursor back to the beginning of the timeline and click 
the play button, we can preview the transition to make sure it occurs at the right 
moment on the audio track. 
 
Add More Text Slides and Images 
As you listen to the audio track, you can pull out important "quotes" and make 
text slides with those words. Add more text slides and other images if you prefer, 
creating transitions between all of them like we did between the first text slide 
and the image of Michael above. 
 
NOTE: The more you overlap one image with another, the slower the dissolve will 
be between the two, and vice versa. 
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Create a Loop Region 
Once you've added all your text slides and images (and saved your project) bring 
the cursor back to the beginning of the timeline and click the "M" key to insert a 
marker. 
 

 
 
Then place your cursor in the little wedge below the number on the marker and 
drag it across the timeline (see below) to create a "Loop Region," which is the 
area of the timeline that will be rendered as a video in a moment. 
 

 
 

Drag the marker all the way across the timeline to the end of the video and 
audio tracks. (See below.) 
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We've created our Loop Region and are now ready to "render" our project as a 
video. 
 
Render Your Project as a Video File 
Select "Render As" from the "File" dropdown menu in Vegas. 
 

 
 
Most video sharing sites accept a variety of formats but there are exceptions. 
You'll find most accept .wmv and/or .mov, so it doesn't hurt to render your 
project as both. 
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Select your preferred file format from the "Save as type" dropdown field and 
make sure the "Render loop region only" box is checked. Then click the Save 
button to render your slideshow video file. 
 
Of course, there's more to Vegas than we just demonstrated and you will be able 
to add music intros and backgrounds as well as other effects the more you 
practice. Once again, to order Sony Vegas, go to the Sony Media Software site 
and select "Vegas" from the "Software" dropdown menu. 
 
Okay, now that you know how to make quick, easy Internet videos, let's put 
them to work! 
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How to Drive Massive Website Traffic with Videos 
 

STEP 1 – A. Properly "optimize" then B. Upload your videos to the top 30+ 
online video sharing sites. 

 
And if you want an extra push… 
 

STEP 2 – A. Tag your videos with social bookmarking sites, B. Link to them 
from blogs and C. Create and distribute podcasts using the audio tracks and 
metadata from your videos. 

 
You can accomplish Step 1 above by creating keyword loaded titles and 
descriptions for your videos. 
 
STEP 1A - Optimize 
Start with your list of keywords and phrases. Create a list of six comma-
separated and six space-separated keywords and phrases. The lists will be 
different if you use a couple two- or three-word phrases in the comma-separated 
list. 
 
From that list, create a few titles or headlines for each video. Use your primary 
keyword or phrase as close to the beginning of your title as possible. Limit each 
title to 64 characters or less.  
 
Also create your video description. Include your target Web site URL close to the 
beginning of the description and mention a couple of your keywords or phrases 
throughout. Create a short and long description. The short description should be 
less than 200 characters; the long description can be as long as 2,000 
characters. 
 
STEP 1B - Upload 
Then if you sign up for our newsletter we'll 
email the link for our Free directory of the top 
30+ online video sharing sites.  
 
This directory covers all the most popular video 
sites with insights about their popularity, target 
audiences, file format and size requirements—
all the information you need to successfully 
upload your videos and generate massive traffic 
on your own. 
 
WARNING: It's a TOTAL HASSLE to Upload 
Your Video to 30 Hosting Services! 
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It takes about half an hour to fill out the information and upload a three-minute 
video to one video hosting service. At that rate, it takes 15 hours to upload your 
video to 30 sites. And that's just one video! If you're serious about generating 
traffic this way, you'll want to produce and upload several videos a week. Using 
this method, it could put a serious dent in your social life! 
 
And not only is it time-consuming and tedious but uploading video also ties up 
your Internet connection like crazy! You're going to wish you had a separate line 
just for video uploads. 
 
STEP 2A - Tag Your Videos with Social Bookmarks 
First, establish accounts at several top social bookmarking sites, for example: 
 

 del.icio.us 
 furl.net 
 myweb2.search.yahoo.com 
 Backflip.com 
 Blinklist.com 
 ClicksaPlenty.com 

 
Each one of these sites has a tool, bookmark or button you can add to your Web 
browser so that when you visit pages you want to bookmark, you can simply 
click the button or bookmark and tag the page.  
 
Here are a couple 
examples: the "TAG" 
icon for del.icio.us and 
the "f" button for 
furl.net. 
 
When you tag a page, you get to add a title, description and keywords to your 
entry—and share it with the rest of the community as well. 
 
The idea is to create links to your videos from these very popular sites using 
these tagging methods.  
 
So, once you've uploaded your video to the top 30 or so video sites, log in to 
each of them, find your video and tag that page at each of the social 
bookmarking sites. 
 
Here's an example using a video we uploaded promoting Traffic Geyser. The 
screen shot below shows the page where it appears on Google video. We find 
this page and tag it with all the social bookmarking tools we have. 
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Once you open accounts at the social bookmarking sites like del.icio.us and 
installed their "tagging" buttons or bookmarks, you can click on each of them—in 
this case, the del.icio.us "TAG" button—and a separate tagging window appears. 
 

 
 

  25 



 

Note there are two open fields which you can and should populate with keyword 
rich information. Simply enter "notes" and "tags" then click Save. We like to use 
the keyword rich description we've already created for our video, as well as our 
primary keywords and phrases. (See below.) 
 

 
 
So, now all you have to do is repeat this process with several other bookmarking 
sites for 30 or so video pages. 
 
 
STEP 2B - Link to Your Videos from Blogs 
As mentioned earlier, linking to your videos from blogs is also very helpful for 
driving traffic. The more links you can create to your videos and target URLs, the 
better. 
 
So, the next thing you should do is establish a few blogs if you don't already 
have them. Here are some Web-based blogging services to help you get started: 
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 Blog.com 
 Blogger.com 
 MySpace.com 
 WordPress.com 
 Xanga.com 
 LiveJournal.com 

 
Then each time you upload a 
new video, create entries in 
each of your blogs using 
your video title, description 
and keywords and link it to 
your target Web page. 
 
In addition, make sure you 
set your settings for your 
blogs to automatically "ping" 
blog indexing sites like 
http://www.Technorati.com/ 
when you update your blog.  
 
(Pinging notifies the index 
sites updated content is 
available and updates the 
link to your blog, generating 
more traffic through RSS 
feeds.) 
 
 
STEP 2C - Create 
Podcasts from Your V
Additional mechanisms for gener

ideos and Distribute Them 
ating traffic are podcasts. Podcasts are audio 

any podcasts are formatted like regular radio shows, with focus on a specific 

s you can guess, the key to successful traffic generation with podcasts is in how 

files distributed for listening online or on portable mp3 players or iPods.  
 
M
topic. However, there are feeds and directories that distribute podcasts to 
millions of Web users who access them via keywords and phrases. 
 
A
you describe them—what titles and keywords you use. 
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Get Your Audio File Ready 
g, strip the audio from your video (or use your 

 you don't have an FTP server, use http://www.Archive.org

To take advantage of podcastin
original audio file if you created a slideshow video) and make it available for 
download through your FTP server. 
 
If . Accounts are free. 
 

 
 

nce you set up an account at Archive.org, FTP your audio file using either O
Internet Explorer or an FTP client like SmartFTP or Filezilla.  
 
Start by naming your item. (See screen shot below.) 
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Archive.org will check to see if there are any other items with the same name 
and if yours is unique, it will assign it to the file you're about to "upload" or ftp to 
the site. 
 
FTP stands for "file transfer protocol." It describes the process by which files 
such as Web pages, videos, audios, etc. are uploaded to servers. Typically, you 
need an FTP client or software program to accomplish this but there are Web 
browser based methods such as what we typically use to upload videos today 
and one of the examples below. 
 
Once you've named your item, you must FTP it to Archive.org. Instructions 
appear to do this in one of two ways, either with Internet Explorer or with an 
FTP client. (See screen shot below.) 
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Just follow the directions and FTP your audio file to Archive.org using one of 
these methods. You have 48 hours to use the directory to upload the file. 
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Here's a screen shot showing how I drag and drop an audio file from my 
computer onto the Archive.org server using the SmartFTP client. 
 

 
 
Once you've done that, you need to "check in" the file at Archive.org.  
Start by clicking on the file in the directory (above) named "CLICK_HERE_ 
WHEN_DONE.htm" in the Archive.org ftp directory. Then click the "check in" link 
on the Archive.org Web page.  
 
After a few moments, you'll receive a message with the link to your item. (See 
below.) Copy this link and save it in Notepad for use later in the process. 
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Next, submit your item for public consumption. Click the "Submit audio" button 
to place your file in Archive.org's Open Source Audio collection.  
 

 
 
Then complete the metadata for the file. (See below.) 
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Pay particular attention to the "title," "description" and "subject" fields. You can 
reuse the keyword-loaded title and description you wrote for your video here.  
 
Once you submit the metadata, you can visit your item. (See below.) 
 

 
 
The link you copied earlier is the URL for this page. Note that you can play the 
audio file from the console in the upper right corner of the item.  
 
Now that you have your audio file uploaded and available for use, it's time to 
create your Podcast feed. 
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Set Up Your Feed 
Start by setting up an account at a service like Rapid Feeds.  
 
Once you've established an account, click "FeedManager" to create a new feed. 
 

 
 

Think of a feed as your Internet radio station. You should give it a title and 
description that will encompass all your related video/audio files. Remember to 
use appropriate keywords in these fields. 
 
Once you've created your feed, you add your item (the page URL on Archive.org 
that contains your audio file) to it.  
 
Think of your item as a radio show on your station. In the Description field, you 
can enter use the WYSIWYG editor or click the link to edit with HTML. 
 
Again, it's critical to enter a keyword/phrase-loaded title and description for best 
traffic-driving results. 
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Paste the link for your Archive.org item page, which you copied from Archive.org 
a few minutes ago and saved in Notepad. Now, click the "Add Podcast" tab at the 
bottom of the screen and paste the link for your audio file there, too. 
 
Click the "Add Item" button. Next you will see a screen similar to the one below. 
 
This is your feed URL. Copy and paste it into your Web browser and check your 
feed and the item you just added. 
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Your feed page will look something like this: 
 

 
 
It contains a link to your page at Archive.org that describes and links to your 
audio file.  
 
Note also how we added our Website URL in the item description and linked to it 
using Rapid Feeds' WYSIWYG editor. Now when someone listens to our file from 
this page, he can click through to our site right there to learn more. 
 
Of course, you can use this method to create as many feeds and items as you 
like for your businesses. It is a great way to repurpose your videos and generate 
additional traffic to your target URLs. 
 
There's one more thing you need to configure in Rapid Feeds—your iTunes 
Podcast. Go back FeedManager Home (tab in upper left of Rapid Feeds) and click 
on the configure icon for your feed. You will see a screen similar to this one: 
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Click the iTunes label under Add ons in the left menu. Then select the "Include" 
radio button at the top of this panel and complete the form. You will have to 
create a 300x300 pixel image to accompany your iTunes Podcast and provide the 
link to it in the "Image URL" field. 
 

Here's one we did for this example. 
 
If you don't have a server to place this image and create 
a URL, go back to Archive.org and upload your image 
there, then get the URL and paste it in here. Your 
Podcast will now also be syndicated via Apple's iTunes 
service, providing more traffic to your site. 
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Here are the steps summarized again: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

How to Make Quick, Easy Internet Videos 
 

STEP 1 – Write a short sales script. 
STEP 2 – Create an audio file from it. 
STEP 3 – Add images to it and generate a video file. 

 
How to Drive Massive Website Traffic with Videos 
 

STEP 1 – Properly "optimize" and upload your videos to the top 30+ 
online video sharing sites. 
STEP 2 – A. Tag your videos with social bookmarking sites, B. Link to 
them from blogs and C. Create and distribute podcasts using the audio 
tracks and metadata from your videos. 

 
Now, read on and find out how to do all this and more…The Easy Way.
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Part 2 – The Easy Way 
 
There's Got to Be a Better Way! 
That's what we think, anyway. So we've invented a system that: 
 

 Records your audio from your phone 
 Creates slideshow videos in minutes 
 Uploads your videos to 30+ top sites quickly and easily—in about the 

same time as it would take you to upload one video to one site 
 Saves your uploads as templates so you can shortcut your 

submissions down to a few minutes 
 Tags those videos AND your target Web site at six social bookmarking 

sites—automatically 
 Posts your videos and information on a blog and pings 20 blog 

directories—automatically 
 Creates podcasts from the audio tracks of your videos and distribute them 

through three feed services—automatically  
 Tracks your submissions for you and give you statistics on how 

many views your videos get 
 
Upload Your Video Just Once & Our System Sends It to All 
the Top Video Sites with the Click A Button? 
That's right. We call it Traffic Geyser. 
 
How Does It Work? Simple… 
 
STEP 1 - Upload one or more videos from your computer to your Traffic Geyser 
library. (You can upload up to five videos at a time.) 
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STEP 2 - Upload a video from your Traffic Geyser library to the free video 
hosting sites. Add titles, keyword tags, descriptive text, etc. THAT'S IT! Traffic 
Geyser automatically tags your videos and your target site at several 
top social bookmarking sites, posts your title, description and 
keywords to blogs (and pings the directories) and podcasts your audio 
for you. 

 

Okay, But Does It Really Work? 
We'll let some of our members tell you. Read on to see recent press releases 
about three Internet marketers who tried Traffic Geyser and were ecstatic about 
their results. 
 
Each of these marketers had previously dabbled with video, but none of them 
realized how powerful and time-saving Traffic Geyser was for generating traffic 
until they tried it. The factor that won over these marketers was how quickly 
they saw dramatic results. 
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Create Slideshow Videos in Minutes 
Using the Slideshow Creator in Traffic Geyser has a couple of advantages: 
 

 You can create slideshow videos quickly and easily 
 Once they're created you can upload them immediately using the Traffic 

Geyser upload service 
 
To create a slideshow video in Traffic Geyser:  
 

1. Name your project. 
 

2. Phone-in to your very own Traffic Geyser toll-free number and 
record your audio file right into media library OR upload an 
existing audio file—either .mp3 or .wav will work.  

 
If you have audio files in other formats, there are many utilities you can use to 
convert the files to .mp3 or .wav. Just Google "convert .yourformat to .mp3 or 
.wav." One utility we have used successfully is the dbpowerAMP Music Converter.  
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3. Create or upload your images.  
 
Traffic Geyser has a built-in text slide creator and several pre-loaded background 
images or you can create your own. You can also use free images from clip art 
services. There are many sources for free, royalty-free images, which you can 
use without fear of copyright infringement. One is Stock.XCHNG. Another is 
Microsoft Office Online's Clip Art Section. Make sure to read the terms of service 
for any stock photo site so you know what your responsibilities are.  
 

4. Choose the quality of the resulting video file then click "Next." 
 
Traffic Geyser shows you a preview of your video, then processes the files and 
creates the actual file, which it places in your "library"—ready to upload. 
 
Set Up Your Video Accounts, Social Bookmarking Sites and 
Podcast Feeds 
When you join Traffic Geyser and initially set up your video site accounts, it's the 
last time you have to actually visit those sites.  
 
From then on, Traffic Geyser automatically logs in and submits your videos and 
descriptive information to all 35 sites for you—each time you tell it to. 
 
Plus, we've incorporated some Web 2.0 elements to help drive traffic not only to 
your videos, but to your targeted Web pages as well. Here's how: 
 

 We use your accounts at several social bookmarking sites (six, as of this 
writing, but we're adding more—sites like del.icio.us, furl.net, etc.) and 
EACH TIME you upload a video, we automatically "tag" your videos AND 
your target URL at each of those sites for you.  

 We also automatically post a thumbnail image from your video and your 
video information (title, description and keywords and phrases) on our 
blogs and link to both your videos AND your target URLs. Traffic Geyser 
automatically creates blog entries when you submit videos, links back to 
your target Web site and pings technocrati.com and 20 other blog 
directories. 

 We also help you create RSS feeds (or "channels") to distribute the 
podcasts Traffic Geyser automatically creates from your videos. That way, 
each time you upload a video, you can also blast out the content—
including your keyword-loaded titles and descriptions AND target Web site 
URLs. 
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Traffic Geyser Features & Benefits Summary 
Here are the features and benefits rolled into Traffic Geyser: 
 

 Massive Website traffic to build your list & sell your products 
 Exceptional search rankings to raise your profile and credibility 
 Built-in phone-in audio file creator with your own toll-free 

number (comes with promo script template, too!) 
 Your own slideshow video production suite built in to the service 

- Text slide creator included with 20 pre-loaded backgrounds 
- 100 music files included 
- Step-by-step instructions to create audio files if you don't 

have any 
- Marries your audio and images to create videos 

 Email your images right into your Traffic Geyser library 
 Built-in automatic video uploading service to 35 (Gold Level) or 15 (Silver 

Level) top video sharing directories and search engines, including 
YouTube, Google video, Yahoo video, iFilm and MySpace video 

 Built-in Web 2.0 social bookmarking 
- Tags your videos at up to 6 social bookmarking sites, creating more 

links and traffic 
 Built-in blog posting and backlinking 

- Automatically creates blog posts from all your video uploads and 
links back to your target sites 

- Automatically pings Technocrati and other directories 
 Built-in podcasting 

- Automatically strips the audio tracks from your videos and creates 
podcast feeds to all the directories, including iTunes 

 Complete how-to videos, tips, techniques and member's forum to help you 
get the most from these powerful tools 

 Bonuses worth almost $300, including the Internet Video Starter 
Kit, royalty-free music pack and Frank Sousa's Secret Spider 
Generator that gets your site pages listed quickly on all the 
search engines 

 
Plus, You Can Cancel Anytime Without Penalty if You're Not Satisfied— 
and Keep the Bonuses
Traffic Geyser memberships are month-to-month. We require no complicated, 
long-term contract and you can cancel anytime after the first month. We truly 
believe in the service and its ongoing value so we don't tie you down and we 
don't try to trick you into a contract you can't get out of.  
 
Plus, if you ever decide to cancel, we'll let you keep the Internet Video Starter 
Kit, the Secret Spider Generator and the Royalty-Free Music Pack. Together, 
these bonuses are worth $297. So, even if you order the Gold Level membership 
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and canceled after the first month, you wouldn't be out any money. You really 
have no risk.  
 
Two Membership Levels – Silver and Gold 
There are two levels of Traffic Geyser monthly membership, Gold and Silver. The 
difference between the two is simple.  
 
With the Gold Level, you can upload 100 videos to 35 (and counting) top video 
sites—i.e., you receive 3,500 "submission credits" every 30 days. 
 
With the Silver Level, you can upload 25 videos to 15 top video sites—i.e., you 
receive 375 "submission credits" every 30 days. 
 
The Gold Level is $97 per month; the Silver Level, $47 per month. Plus, there is 
an initiation or service set-up fee of $200 to join, so the first payment is either 
$297 (Gold) or $247 (Silver). 
 
(Compare everything you get with Traffic Geyser for $47 or $97 a month to what 
you get for an equivalent investment in pay-per-click advertising.) 
 
REMEMBER: Whether you join at the Gold or Silver Level, you get all the bonuses 
and additional traffic-producing features such as the social bookmarking, 
blogging and podcasting—plus the Slideshow Video Creator. 
 
Instant Access 
Once you join, you'll get instant access to Traffic Geyser, the bonuses, the 
Member Site and Forum. You can start uploading videos instantly—or you can 
start creating your own slideshow videos with the built-in Slideshow Creator then 
upload them. 
 
Then, as Internet marketer Len Foley says,  
 

"Sit back and watch the traffic roll in!" 
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Special Offers for Readers 
 
Unadvertised $500 Discount for the Internet Infomercial 
Toolkit 
We've made a special arrangement 
for readers who wish to learn how to 
produce promotional AND 
instructional videos (content, 
information products, etc.) to p
a $500 discount for the 

rovide 
Internet 

Infomercial Toolkit.  
 
The Toolkit normally sells for $997 
but our readers can order it for just 
$497 simply by following this link: 
Internet Infomercial Toolkit. 
 
Here's what to do: 

1. Fill in the form on the squeeze page to get the free gifts. 
2. Examine the Toolkit information on the following page. 
3. Choose Payment Option #1 the bottom of the page to order the Toolkit. 
4. Click the "Check Out" button. 
5. The $500 discount will appear on the Order Page. Complete the order 

form and click "Submit Order" at the bottom of the page. 
 
Click here to get a sneak preview of the Internet Infomercial Toolkit. 
 
Resale Rights to This Ebook 
You may freely distribute copies of this eBook if you register first at this location: 
 

Your Version of "How to Cash in on the New Internet and Flood Your Business 
with Customers"

 
WARNING: Do NOT use a spam-protected email to register or you will not 
receive your copy of the eBook. 
 
Once you register, you will be able to personalize your copy with your own 
affiliate links to Traffic Geyser, the Internet Video Starter Kit, Sony Software, etc. 
 
That way, when you distribute your version of this eBook, it will contain links that 
make money for you when your readers click through to those sites and order.

http://www.infomercialtoolkit.com/sneak
http://www.trafficgeyser.com/ebookreg.html
http://www.trafficgeyser.com/ebookreg.html
https://www.mcssl.com/app/adtrack.asp?MerchantID=68685&AdID=304061&u=www.infomercialtoolkit.com
https://www.mcssl.com/app/adtrack.asp?MerchantID=68685&AdID=304061&u=www.infomercialtoolkit.com


 

 


